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Warum müssen Sie Ihre Schriften verwalten?
Ihre Schriften sind Ihre Werkzeuge. Sie müssen wissen, wo sie sich befinden und wie und wann 
Sie diese verwenden. Wenn Sie über eine große Sammlung von Schriften verfügen, ist ein effektives 
Font Management unerlässlich.

• Wenn Sie alle Ihre Schriften im Standardverzeichnis von Windows installieren, ist das 
Navigieren durch die Schriftenmenüs in Ihren Anwendungen sehr beschwerlich

• Verschiedene Projekte verwenden möglicherweise unterschiedliche Versionen derselben Schrift
• Die Installation neuer Anwendungen kann zu unerwarteten Änderungen an Ihren Schriften 

führen
• Das Ersetzen beschädigter oder fehlender Schriften und das Aussortieren doppelter Schriften 

verschwendet produktive Zeit

Dieser überarbeitete Praxisleitfaden bewährter Verfahren für das Windows Font Management enthält 
nur die Informationen, die Sie benötigen, um Ihre Schriften unter Kontrolle zu bekommen. Es bezieht 
sich auf Windows 7 und Windows 10.

Die bewährten Verfahren für ein effektives Font Management
• Sichern Sie Ihre Dateien
• Suchen Sie nach Updates (Aktualisierungen) für Ihr Betriebssystem und Ihre Programme 

(Anwendungs-Software)
• Bereinigen Sie die Schriftordner ihres Betriebssystems
• Identifizieren Sie beschädigte und inkompatible Schriften
• Aktualisieren Sie ältere Schriften
• Sortieren Sie doppelte Schriften aus
• Fügen Sie Schriften einem Fontmanager hinzu
• Erstellen Sie einen Plan zur Pflege Ihrer Schriften
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Über diesen Praxisleitfaden
Dieser Praxisleitfaden enthält Empfehlungen und Anweisungen, die Ihnen beim Verwalten Ihrer 
Schriften unter Windows helfen. Es umfasst:

• Das Erfassen Ihrer Schriften
• Den Umgang mit alten, beschädigten und doppelten Schriften
• Das Organisieren von Schriften mit Suitcase Fusion
• Die Vorausplanung für neue Schriften

In diesem Praxisleitfaden verwendete Konventionen
Fett

 Zeigt neue Begriffe und Titel für Abschnitte dieses Praxisleitfadens an.

Kursiv 

 URLs und Ordnerpfade, Ordner- und Dateinamen sowie Dateierweiterungen an.

Fettdruck mit fester Breite
 Zeigt Befehle an, die genau wie dargestellt eingegeben werden sollten.

Menübefehle werden durch eine rechtwinklige Klammer hinter dem Menünamen angezeigt 
(z.B. Bearbeiten > Alles auswählen (Edit > Select All)). Menübefehle in Untermenüs verwenden 
eine Klammer hinter dem Namen des Untermenüs (z.B. Ansicht > Anordnung nach > Name 
(View > Arrange By > Name)).

Pfade, die mit einem Laufwerksbuchstaben beginnen, sind lokale Pfade (C:\Windows\Fonts\). 
Pfade, die mit zwei Schrägstrichen beginnen, sind Netzwerkpfade (\\ServerName\ShareName\Folder\). 
Ordnerpfade, die nicht mit einem Schrägstrich beginnen, sind relative Pfade (Gehen Sie zu 
Optional Fonts\Office Fonts\ auf ihrem Desktop).

Ein Pfad, der mit einem Ordner endet, endet mit einem Schrägstrich (C:\Users\Administrator\); 
ein Pfad, der mit einem Dateinamen endet, nicht (wie z.B. C:\Windows\Fonts\Calibri.ttf).

Schritte, die sich auf das Drücken der Windows-Logo-Taste beziehen, verwenden das Windows-Logo 
für die Tastaturkombination ( + E). Schritte, die sich auf das Startmenü beziehen, verwenden den 
Menünamen.

Die Anweisungen in diesem Praxisleitfaden setzen voraus, dass Sie für Ihr Windows-Benutzerkonto 
Administratoren-Rechte für Ihren PC haben. Die Anweisungen funktionieren zwar auch als normaler 
Benutzer, aber einige der Befehle erfordern die Eingabe von Benutzername und Passwort eines 
Administratorkontos.
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Erfassen Sie Ihre Schriften
Die Verwaltung Ihrer Schriften bedeutet, Ihre Schriften zu erfassen und zu überprüfen, um 
beschädigte, inkompatible und doppelte Schriften zu finden. Diese Schritte sind gleich, egal ob Sie 
mit einem brandneuen Windows PC beginnen oder auf einem Produktionssystem arbeiten, auf dem 
andere Software und Schriften installiert sind.

Sichern Sie Ihre Dateien
Bevor Sie ein Projekt starten, das Änderungen an Ihrem PC vornimmt, sollten Sie Ihre wichtigen 
Dateien sichern, falls etwas schief geht. Informationen zur Sicherungssoftware von Drittanbietern 
finden Sie in der Dokumentation des jeweiligen Programms.

Sie können einen Wiederherstellungspunkt in Windows erstellen. Wenn etwas schief geht, können 
Sie Ihr Windows-System wieder auf den Wiederherstellungspunkt zurücksetzen und neu starten. 
Weitere Informationen finden Sie im Anhang A: Arbeiten mit Windows-Wiederherstellungspunkten 
auf Seite 16.

Suche nach Updates (Aktualisierungen) für Ihr Betriebssystem- und Ihre  
Anwendungs-Software (Programme)
Sie sollten auch immer sicherstellen, dass Ihr Betriebssystem und Ihre Anwendungen auf dem 
neuesten Stand sind. Updates können Systemschriften hinzufügen, aktualisieren oder entfernen.

Windows 7: Klicken Sie auf „Start“ und wählen Sie dann „Systemsteuerung“. Wählen Sie 
„Windows Update“; wenn keine Updates verfügbar sind, klicken Sie auf „Nach Updates suchen“.

Windows 10: Klicken Sie auf „Start“ und wählen Sie „Einstellungen“. Wählen Sie „Updates & 
Sicherheit“; wenn keine Updates verfügbar sind, klicken Sie auf „Nach Updates suchen“.

Die meisten Anwendungen haben ihre eigenen Methoden, Updates (Aktualisierungen) zu installieren.  
Überprüfen Sie die jeweilige Dokumentation dieser Anwendungen.

Dateierweiterungen anzeigen
Wenn Sie mit Schriften arbeiten, müssen Sie den Unterschied zwischen Schriftdateien erkennen 
können: Garamond.ttf und Garamond.otf können unterschiedliche Glyphen und Merkmale aufweisen. 
Um dies zu erleichtern, müssen Sie Dateierweiterungen im Datei-Explorer sichtbar machen.

Windows 7: Drücken Sie  + E, um ein Explorer-Fenster zu öffnen, und wählen Sie Organisieren > 
Ordner und „Suchoptionen“ (Organize > Folder and search options). Klicken Sie im Fenster 
„Ordneroptionen“ auf die Registerkarte „Ansicht“ (View tab), und deaktivieren Sie das 
Kontrollkästchen „Erweiterungen für bekannte Dateitypen ausblenden“ und klicken Sie 
dann auf „OK“.

Windows 10: Drücken Sie  + E, um ein Datei-Explorer-Fenster zu öffnen. Klicken Sie oben in 
der Multifunktionsleiste auf die Registerkarte „Ansicht“ (View tab)und aktivieren Sie dann 
im Abschnitt „Anzeigen/Verbergen“ die Option „Dateinamenerweiterungen“ im Bereich 
„Einblenden/ Verbergen“.

Damit werden die Dateierweiterungen für alle Ihre Dateien angezeigt, nicht nur für Ihre 
Schriftdateien: .doc oder .docx für Word Dateien, .exe für Anwendungen, usw. Wenn Sie 
fertig sind, können Sie die Dateinamenerweiterungen wieder ausblenden.
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Ändern Sie die Ansichtseinstellungen für den Schriftordner
Wenn Sie C:\Windows\Fonts\ im Datei-Explorer öffnen, verwendet Windows das Layout aus dem 
Fonts-Control Panel. Das Kontrollfeld „Schriften“ erleichtert das Durchsuchen und Anzeigen 
der Schriften. Es ist jedoch schwieriger, den Ordner „Schriften“ zu bereinigen. Sie können die 
Einstellungen für den Ordner „Schriften“ ändern, um ihn als normalen Ordner anzuzeigen.

Windows 7: Klicken Sie auf „Start“ und wählen Sie „Alle Programme“> „Zubehör“ (All Programs > 
Accessories). Klicken Sie mit der rechten Maustaste auf die Eingabeaufforderung, und wählen 
Sie im Dropdown-Menü die Option „Als Administrator ausführen“ (Run as administrator) aus.

Windows 10: Klicken Sie mit der rechten Maustaste auf „Start“ und wählen Sie dann 
Eingabeaufforderung (Admin).

Windows fragt Sie, ob Sie die Eingabeaufforderung ausführen möchten, um Änderungen an Ihrem 
Computer vorzunehmen; klicken Sie auf „Ja“ (Yes). Nachdem sich das Eingabeaufforderungsfenster 
geöffnet hat, geben Sie attrib -r -s C:\Windows\Fonts\ ein und drücken Sie die Eingabetaste. 
Wenn Sie das nächste Mal C:\Windows\Fonts\ öffnen, sollte es als normaler Ordner erscheinen.

Um die Ansicht wieder zu ändern, öffnen Sie ein Administrator-Eingabeaufforderungsfenster und 
geben Sie attrib +r +s C:\Windows\Fonts\ ein, und drücken Sie die Eingabetaste.

Bereinigen Ihrer Systemschriften
Als Nächstes sollten Sie erwägen, nicht benötigte Schriften aus Ihrem Schriftenordner zu entfernen. 
Erstellen Sie auf Ihrem Desktop einen Ordner mit dem Namen Optionale Schriften (Optional Fonts).

Warum sollten Systemschriften bereinigt werden?
Wenn Sie zu viele Schriften auf Ihrem System behalten, kann dies dazu führen, dass Ihre 
Schriftmenüs zu einem unhandlichen Durcheinander werden. Kreative Anwendungen lassen Sie 
jetzt besser durch lange Listen von Schriften navigieren, es kann jedoch immer noch schwierig sein, 
die gewünschten Schriften zu finden.

Klassifizieren Ihrer Systemschriften
Sie können die Schriften auf Ihrem Computer in verschiedene Kategorien einteilen:

• Von Windows installierte Schriften
• Schriften von Drittanbietern, einschließlich von Adobe und anderen Anwendungen

Beibehaltung der wichtigsten Systemschriften
Microsoft bietet Knowledge Base-Artikel an, in denen die in Windows standardmäßig installierten 
Schriften nach Version aufgelistet sind. In jeder Version von Windows werden unterschiedliche 
Schriften installiert und die Liste der installierten Schriften für jede Version ist unterschiedlich.

• Windows 7: Schriftenliste Windows 7
• Windows 10: Schriftenliste Windows 10
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AGENCYB.TTF

AGENCYR.TTF

ALGER.TTF

ANTQUAB.TTF

ANTQUABI.TTF

ANTQUAI.TTF

ARIALN.TTF

ARIALNB.TTF

ARIALNBI.TTF

ARIALNI.TTF

ARIALUNI.TTF

ARLRDBD.TTF

BASKVILL.TTF

BAUHS93.TTF

BELL.TTF

BELLB.TTF

BELLI.TTF

BERNHC.TTF

BKANT.TTF

BODB.TTF

BODBI.TTF

BODBLAI.TTF

BODBLAR.TTF

BODCB.TTF

BODCBI.TTF

BODCI.TTF

BODCR.TTF

BODI.TTF

BODPSTC.TTF

BODR.TTF

BOOKOS.TTF

BOOKOSB.TTF

BOOKOSBI.TTF

BOOKOSI.TTF

BRADHITC.TTF

BRITANIC.TTF

BRLNSB.TTF

BRLNSDB.TTF

BRLNSR.TTF

BROADW.TTF

BRUSHSCI.TTF

BSSYM7.TTF

CALIFB.TTF

CALIFI.TTF

CALIFR.TTF

CALIST.TTF

CALISTB.TTF

CALISTBI.TTF

CALISTI.TTF

CASTELAR.TTF

CENSCBK.TTF

CENTAUR.TTF

CENTURY.TTF

CHILLER.TTF

COLONNA.TTF

COOPBL.TTF

COPRGTB.TTF

COPRGTL.TTF

CURLZ.TTF

ELEPHNT.TTF

ELEPHNTI.TTF

ENGR.TTF

ERASBD.TTF

ERASDEMI.TTF

ERASLGHT.TTF

ERASMD.TTF

FELIXTI.TTF

FORTE.TTF

FRABK.TTF

FRABKIT.TTF

FRADM.TTF

FRADMCN.TTF

FRADMIT.TTF

FRAHV.TTF

FRAHVIT.TTF

FRAMDCN.TTF

FREESCPT.TTF

FRSCRIPT.TTF

FTLTLT.TTF

GARA.TTF

GARABD.TTF

Erfassen von Schriften aus der Adobe Creative Suite & Creative Cloud
Adobe Creative Suite 6 wird von Windows 10 nicht unterstützt. Bei der Deinstallation von Creative 
Suite 6 werden jedoch möglicherweise Schriften in C:\Windows\Fonts\ hinterlassen. Weitere 
Informationen finden Sie unter: In Adobe Creative Suite 6 enthaltene Schriften. Erstellen Sie einen 
Ordner mit dem Namen Adobe Fonts in Ihrem Ordner Optionale Fonts, und verschieben Sie alle 
gefundenen Adobe Fonts in Ihren Ordner Adobe Fonts.

Die Adobe Creative Cloud installiert keine Schriften mehr in Ihren Systemordnern. Creative Cloud 
verwendet Adobe-Schriften (früher bekannt als TypeKit), um seine Schriften zu verteilen; weitere 
Informationen finden Sie in den FAQ Creative Cloud Fonts.

Erfassen von Schriften aus Microsoft Office
Erstellen Sie einen Ordner mit dem Namen Office Fonts in Ihrem Ordner Optional Fonts. 

Microsoft Office 2010
Die folgenden Schriften werden von Microsoft Office 2010 unter Windows 7 installiert:
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GARAIT.TTF

GIGI.TTF

GILBI.TTF

GILB.TTF

GILC.TTF

GILI.TTF

GILLUBCD.TTF

GILSANUB.TTF

GIL.TTF

GLECB.TTF

GLSNECB.TTF

GOTHIC.TTF

GOTHICB.TTF

GOTHICBI.TTF

GOTHICI.TTF

GOUDOS.TTF

GOUDOSB.TTF

GOUDOSI.TTF

GOUDYSTO.TTF

HARLOWSI.TTF

HARNGTON.TTF

HATTEN.TTF

HTOWERT.TTF

HTOWERTI.TTF

IMPRISHA.TTF

INFROMAN.TTF

ITCBLKAD.TTF

ITCEDSCR.TTF

ITCKRIST.TTF

JOKERMAN.TTF

JUICE.TTF

KUNSTLER.TTF

LATINWD.TTF

LBRITE.TTF

LBRITED.TTF

LBRITEDI.TTF

LBRITEI.TTF

LCALLIG.TTF

LFAX.TTF

LFAXD.TTF

LFAXDI.TTF

LFAXI.TTF

LHANDW.TTF

LSANS.TTF

LSANSD.TTF

LSANSDI.TTF

LSANSI.TTF

LTYPE.TTF

LTYPEB.TTF

LTYPEBO.TTF

LTYPEO.TTF

MAGNETOB.TTF

MAIAN.TTF

MATURASC.TTF

MISTRAL.TTF

MOD20.TTF

MTCORSVA.TTF

NIAGENG.TTF

NIAGSOL.TTF

OCRAEXT.TTF

OLDENGL.TTF

ONYX.TTF

OUTLOOK.TTF

PALSCRI.TTF

PAPYRUS.TTF

PARCHM.TTF

PERBI.TTF

PERB.TTF

PERI.TTF

PERTIBD.TTF

PERTILI.TTF

PER.TTF

PLAYBILL.TTF

POORICH.TTF

PRISTINA.TTF

RAGE.TTF

RAVIE.TTF

REFSAN.TTF

REFSPCL.TTF

ROCCB.TTF

ROCC.TTF

ROCK.TTF

ROCKB.TTF

ROCKBI.TTF

ROCKEB.TTF

ROCKI.TTF

SCHLBKB.TTF

SCHLBKBI.TTF

SCHLBKI.TTF

SCRIPTBL.TTF

SHOWG.TTF

SNAP.TTF

STENCIL.TTF

TCBI.TTF

TCB.TTF

TCCB.TTF

TCCEB.TTF

TCCM.TTF

TCMI.TTF

TCM.TTF

TEMPSITC.TTF

VINERITC.TTF

VIVALDII.TTF

VLADIMIR.TTF

WINGDNG2.TTF

WINGDNG3.TTF

Verschieben Sie diese Schriften in Ihren Ordner Office Fonts.
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Microsoft Office 2013 
Die folgenden Schriften werden von Microsoft Office 2013 unter Windows 7 und Windows 10 
installiert:

AGENCYB.TTF

AGENCYR.TTF

ALGER.TTF

ANTQUAB.TTF

ANTQUABI.TTF

ANTQUAI.TTF

ARIALN.TTF

ARIALNB.TTF

ARIALNBI.TTF

ARIALNI.TTF

ARIALUNI.TTF

ARLRDBD.TTF

BASKVILL.TTF

BAUHS93.TTF

BELL.TTF

BELLB.TTF

BELLI.TTF

BERNHC.TTF

BKANT.TTF

BODB.TTF

BODBI.TTF

BODBLAI.TTF

BODBLAR.TTF

BODCB.TTF

BODCBI.TTF

BODCI.TTF

BODCR.TTF

BODI.TTF

BODPSTC.TTF

BODR.TTF

BOOKOS.TTF

BOOKOSB.TTF

BOOKOSBI.TTF

BOOKOSI.TTF

BRADHITC.TTF

BRITANIC.TTF

BRLNSB.TTF

BRLNSDB.TTF

BRLNSR.TTF

BROADW.TTF

BRUSHSCI.TTF

BSSYM7.TTF

CALIFB.TTF

CALIFI.TTF

CALIFR.TTF

CALIST.TTF

CALISTB.TTF

CALISTBI.TTF

CALISTI.TTF

CASTELAR.TTF

CENSCBK.TTF

CENTAUR.TTF

CENTURY.TTF

CHILLER.TTF

COLONNA.TTF

COOPBL.TTF

COPRGTB.TTF

COPRGTL.TTF

CURLZ.TTF

ELEPHNT.TTF

ELEPHNTI.TTF

ENGR.TTF

ERASBD.TTF

ERASDEMI.TTF

ERASLGHT.TTF

ERASMD.TTF

FELIXTI.TTF

FORTE.TTF

FRABK.TTF

FRABKIT.TTF

FRADM.TTF

FRADMCN.TTF

FRADMIT.TTF

FRAHV.TTF

FRAHVIT.TTF

FRAMDCN.TTF

FREESCPT.TTF

FRSCRIPT.TTF

FTLTLT.TTF

GARA.TTF

GARABD.TTF

GARAIT.TTF

GIGI.TTF

GILBI.TTF

GILB.TTF

GILC.TTF

GILI.TTF

GILLUBCD.TTF

GILSANUB.TTF

GIL.TTF

GLECB.TTF

GLSNECB.TTF

GOTHIC.TTF

GOTHICB.TTF

GOTHICBI.TTF

GOTHICI.TTF

GOUDOS.TTF

GOUDOSB.TTF

GOUDOSI.TTF

GOUDYSTO.TTF

HARLOWSI.TTF

HARNGTON.TTF

HATTEN.TTF

HTOWERT.TTF

HTOWERTI.TTF

IMPRISHA.TTF

INFROMAN.TTF

ITCBLKAD.TTF

ITCEDSCR.TTF

ITCKRIST.TTF

JOKERMAN.TTF

JUICE.TTF

KUNSTLER.TTF

LATINWD.TTF
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LBRITE.TTF

LBRITED.TTF

LBRITEDI.TTF

LBRITEI.TTF

LCALLIG.TTF

LFAX.TTF

LFAXD.TTF

LFAXDI.TTF

LFAXI.TTF

LHANDW.TTF

LSANS.TTF

LSANSD.TTF

LSANSDI.TTF

LSANSI.TTF

LTYPE.TTF

LTYPEB.TTF

LTYPEBO.TTF

LTYPEO.TTF

MAGNETOB.TTF

MAIAN.TTF

MATURASC.TTF

MISTRAL.TTF

MOD20.TTF

MSUIGHUB.TTF

MTCORSVA.TTF

NIAGENG.TTF

NIAGSOL.TTF

OCRAEXT.TTF

OLDENGL.TTF

ONYX.TTF

OUTLOOK.TTF

PALSCRI.TTF

PAPYRUS.TTF

PARCHM.TTF

PERBI.TTF

PERB.TTF

PERI.TTF

PERTIBD.TTF

PERTILI.TTF

PER.TTF

PLAYBILL.TTF

POORICH.TTF

PRISTINA.TTF

RAGE.TTF

RAVIE.TTF

REFSAN.TTF

REFSPCL.TTF

ROCCB.TTF

ROCC.TTF

ROCK.TTF

ROCKB.TTF

ROCKBI.TTF

ROCKEB.TTF

ROCKI.TTF

SCHLBKB.TTF

SCHLBKBI.TTF

SCHLBKI.TTF

SCRIPTBL.TTF

SHOWG.TTF

SNAP.TTF

STENCIL.TTF

TCBI.TTF

TCB.TTF

TCCB.TTF

TCCEB.TTF

TCCM.TTF

TCMI.TTF

TCM.TTF

TEMPSITC.TTF

VINERITC.TTF

VIVALDII.TTF

VLADIMIR.TTF

WINGDNG2.TTF

WINGDNG3.TTF

Die folgenden Schriften werden von Microsoft Office 2013 nur unter Windows 7 installiert:

GADUGI.TTF

GADUGIB.TTF

MSJH.TTC

MSJHBD.TTC

MSYH.TTC

MSYHBD.TTC

NIRMALA.TTF

NIRMALAB.TTF

SEGOEUISL.TTF

Die folgenden Schriften werden von Microsoft Office 2013 nur unter Windows 10 installiert:
LEELAWAD.TTF

LEELAWDB.TTF

MSUIGHUR.TTF

Verschieben Sie diese Schriften in Ihren Ordner Office Fonts.
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AGENCYB.TTF

AGENCYR.TTF

ALGER.TTF

ANTQUAB.TTF

ANTQUABI.TTF

ANTQUAI.TTF

ARIALN.TTF

ARIALNB.TTF

ARIALNBI.TTF

ARIALNI.TTF

ARLRDBD.TTF

BASKVILL.TTF

BAUHS93.TTF

BELL.TTF

BELLB.TTF

BELLI.TTF

BERNHC.TTF

BKANT.TTF

BODB.TTF

BODBI.TTF

BODBLAI.TTF

BODBLAR.TTF

BODCB.TTF

BODCBI.TTF

BODCI.TTF

BODCR.TTF

BODI.TTF

BODPSTC.TTF

BODR.TTF

BOOKOS.TTF

BOOKOSB.TTF

BOOKOSBI.TTF

BOOKOSI.TTF

BRADHITC.TTF

BRITANIC.TTF

BRLNSB.TTF

BRLNSDB.TTF

BRLNSR.TTF

Microsoft Office 2016
Die folgenden Schriften werden von Microsoft Office 2016 unter Windows 7 und Windows 10 
installiert:

BROADW.TTF

BRUSHSCI.TTF

BSSYM7.TTF

CALIFB.TTF

CALIFI.TTF

CALIFR.TTF

CALIST.TTF

CALISTB.TTF

CALISTBI.TTF

CALISTI.TTF

CASTELAR.TTF

CENSCBK.TTF

CENTAUR.TTF

CENTURY.TTF

CHILLER.TTF

COLONNA.TTF

COOPBL.TTF

COPRGTB.TTF

COPRGTL.TTF

CURLZ.TTF

ELEPHNT.TTF

ELEPHNTI.TTF

ENGR.TTF

ERASBD.TTF

ERASDEMI.TTF

ERASLGHT.TTF

ERASMD.TTF

FELIXTI.TTF

FORTE.TTF

FRABK.TTF

FRABKIT.TTF

FRADM.TTF

FRADMCN.TTF

FRADMIT.TTF

FRAHV.TTF

FRAHVIT.TTF

FRAMDCN.TTF

FREESCPT.TTF

FRSCRIPT.TTF

FTLTLT.TTF

GARA.TTF

GARABD.TTF

GARAIT.TTF

GIGI.TTF

GILBI.TTF

GILB.TTF

GILC.TTF

GILI.TTF

GILLUBCD.TTF

GILSANUB.TTF

GIL.TTF

GLECB.TTF

GLSNECB.TTF

GOTHIC.TTF

GOTHICB.TTF

GOTHICBI.TTF

GOTHICI.TTF

GOUDOS.TTF

GOUDOSB.TTF

GOUDOSI.TTF

GOUDYSTO.TTF

HARLOWSI.TTF

HARNGTON.TTF

HATTEN.TTF

HTOWERT.TTF

HTOWERTI.TTF

IMPRISHA.TTF

INFROMAN.TTF

ITCBLKAD.TTF

ITCEDSCR.TTF

ITCKRIST.TTF

JOKERMAN.TTF

JUICE.TTF

KUNSTLER.TTF

LATINWD.TTF

LBRITE.TTF
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NIAGSOL.TTF

OCRAEXT.TTF

OLDENGL.TTF

ONYX.TTF

OUTLOOK.TTF

PALSCRI.TTF

PAPYRUS.TTF

PARCHM.TTF

PERBI.TTF

PERB.TTF

PERI.TTF

PERTIBD.TTF

PERTILI.TTF

PER.TTF

PLAYBILL.TTF

POORICH.TTF

PRISTINA.TTF

RAGE.TTF

RAVIE.TTF

REFSAN.TTF

REFSPCL.TTF

ROCCB.TTF

ROCC.TTF

ROCK.TTF

ROCKB.TTF

LBRITED.TTF

LBRITEDI.TTF

LBRITEI.TTF

LCALLIG.TTF

LFAX.TTF

LFAXD.TTF

LFAXDI.TTF

LFAXI.TTF

LHANDW.TTF

LSANS.TTF

LSANSD.TTF

LSANSDI.TTF

LSANSI.TTF

LTYPE.TTF

LTYPEB.TTF

LTYPEBO.TTF

LTYPEO.TTF

MAGNETOB.TTF

MAIAN.TTF

MATURASC.TTF

MISTRAL.TTF

MOD20.TTF

MSUIGHUB.TTF

MTCORSVA.TTF

NIAGENG.TTF

ROCKBI.TTF

ROCKEB.TTF

ROCKI.TTF

SCHLBKB.TTF

SCHLBKBI.TTF

SCHLBKI.TTF

SCRIPTBL.TTF

SHOWG.TTF

SNAP.TTF

STENCIL.TTF

TCBI.TTF

TCB.TTF

TCCB.TTF

TCCEB.TTF

TCCM.TTF

TCMI.TTF

TCM.TTF

TEMPSITC.TTF

VINERITC.TTF

VIVALDII.TTF

VLADIMIR.TTF

WINGDNG2.TTF

WINGDNG3.TTF

Die folgenden Schriften werden von Microsoft Office 2016 nur unter Windows 10 installiert:
LEELAWAD.TTF

LEELAWDB.TTF

MSUIGHUR.TTF

Die folgenden Schriften werden von Microsoft Office 2016 nur unter Windows 7 installiert:
GADUGI.TTF

GADUGIB.TTF

MSJH.TTC

MSJHBD.TTC

MSYH.TTC

MSYHBD.TTC

NIRMALA.TTF

NIRMALAB.TTF

SEGOEUISL.TTF

Verschieben Sie diese Schriften in Ihren Ordner Office Fonts.
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Bereinigung und Organisation Ihrer Schriften
Identifizieren beschädigter und inkompatibler Schriften
Mit der Zeit können Probleme mit Ihren Schriften auftreten.

• Schriften können beschädigt werden, wenn Sie diese von Computer zu Computer verschieben
• Ältere Schriftformate werden in aktuellen Versionen von Windows nicht unterstützt
• Ältere Schriften können inkonsistente interne Schrift-Metadaten haben oder andere 

Fehler - Schriften sind auch Software!

Sie können Ihre Schriften in FontDoctor scannen, um festzustellen, ob sie beschädigt oder nicht 
kompatibel sind. Suitcase Fusion überprüft automatisch Schriften auf Probleme, wenn Sie zur 
Schriftbibliothek hinzufügen.

Beim Kauf von Suitcase Fusion erhalten Sie eine kostenlose Kopie von FontDoctor.
FontDoctor kann auch separat erworben werden.

Scannen Ihrer Schriften mit FontDoctor
FontDoctor durchsucht Schriften nach häufigen Problemen, z. B. inkompatiblen Schriftformaten, 
beschädigten oder unvollständigen sowie doppelten Schriften.

1. Öffnen Sie FontDoctor
2. Ziehen Sie den Ordner mit den zu scannenden Schriften aus dem Explorer und legen Sie ihn 

im FontDoctor-Fenster ab

FontDoctor generiert einen Bericht über die gefundenen Probleme und kann Problemschriften unter 
Quarantäne stellen. Weitere Informationen zu den Optionen, die FontDoctor anbietet, finden Sie 
unter Hilfe > Hilfe anzeigen.

Aktualisieren älterer Schriften auf neue Formate
Es ist nicht immer einfach, die von Ihnen verwendeten Schriften zu ersetzen, insbesondere bei der 
Arbeit mit Dokumenten, die Sie nicht erstellt haben. Es gibt gute Gründe, auf die Verwendung von 
OpenType-Schriften (oder TrueType, wenn OpenType-Versionen nicht verfügbar sind) umzusteigen:

• Sie können OpenType- und Windows TrueType-Schriften sowohl unter Windows als auch 
unter Mac OS verwenden

• PostScript Type 1-Schriften waren betriebssystemspezifisch; Glyphen werden möglicherweise 
unterschiedlichen Zeichen zugeordnet, was beim Wechsel der Plattform zu Anzeigefehlern 
führen kann

• OpenType ist das modernste Format für Schriften und bietet Funktionen, die Typ-1- und 
TrueType-Schriften nicht bieten

• Die meisten Schrifthersteller produzieren heute nur noch OpenType-Versionen ihrer Schriften

Sie können ältere Legacy-Schriften in Ihrem Font-Manager behalten und bei Bedarf für ältere Projekte 
aktivieren. Die meisten Hersteller berechnen Gebühren für neue Versionen von Schriften. Sie können 
jedoch prüfen, ob kostenlose Upgrades angeboten werden.

Identifizierung doppelter Schriften
Eine der größten Herausforderungen für das Font-Management besteht darin, doppelte Schriften 
zu haben.
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Möglicherweise haben Sie mehr als eine Kopie der gleichen Schrift. Vielleicht haben Sie mehr als 
einmal heruntergeladen oder dem Betriebssystem hinzugefügt, aber das Original nicht gelöscht. Das 
ist einfach zu klären: Wählen Sie, welche Kopie Sie behalten möchten, und löschen Sie die anderen.

Das Hauptproblem sind Schriften, die gleiche Schriftenform haben, wie Helvetica oder Garamond, aber 
keine exakten Kopien sind. Möglicherweise verfügen Sie über TrueType- und OpenType Versionen 
Ihrer Schriften. Möglicherweise verwenden Sie zwei verschiedene Versionen derselben Schrift. Die 
neuere Version könnte mehr Glyphen enthalten, das Kerning und den Zeilenabstand anpassen oder 
neue OpenType-Funktionen hinzufügen, z. B. benutzerdefinierte Ligaturen.

Wenn Sie doppelte Schriften haben, ist es wahrscheinlich, dass Sie in verschiedenen Projekten 
unterschiedliche Versionen verwendet haben. Wenn Sie die im linken Beispiel gezeigte Version 
loswerden, erhalten Sie möglicherweise ein Projekt, das wie das rechte Beispiel aussieht: Der Text wird 
anders umgebrochen und führt zu Unterschieden bei der Neuformatierung und beim Seitenumbruch.

   
Die Verwendung von Suitcase Fusion zur Verwaltung doppelter Schriften wird in Verwalten Ihrer 
Schriften mit Suitcase Fusion auf Seite 13 behandelt.

Identifizierung doppelter Schriften mit FontDoctor
FontDoctor kann doppelte Schriften identifizieren und in Quarantäne stellen.

1. Öffnen Sie FontDoctor
2. Damit FontDoctor einen Ordner mit Schriften scannen kann, ziehen Sie das entsprechende 

Ordnersymbol aus dem Explorer und legen Sie es im FontDoctor-Fenster ab

Wenn FontDoctor mehr als eine Schrift mit dem gleichen PostScript-Namen und Schriftformat findet, 
erlaubt es Ihnen, die ältere Version unter Quarantäne zu stellen und die neuere Version zu behalten. 
Wenn Sie möchten, dass FontDoctor automatisch alle Versionen einer Schrift beibehält:

1. Klicken Sie auf „Einstellungen“
2. Um doppelte Schriften zu finden, klicken Sie auf Advanced Diagnosis Options
3. Stellen Sie sicher, dass Mehrere Versionen derselben Schrift erlauben aktiviert ist

Der PostScript-Name einer Schrift ist ein interner Teil von Metadaten, die Windows und Anwendungen 
zur Identifizierung von Schriften verwenden. Dies kann sich vom Dateinamen der Schrift und vom 

Displaynamen der Schrift unterscheiden. Der Displayname einer Schrift wird im Menü oder Dialogfeld 
der Anwendung angezeigt.
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Verwalten Ihrer Schriften mit Suitcase Fusion
Sobald Sie Ihre Schriften gesammelt und bereinigt haben, können Sie diese zu Suitcase Fusion hinzufügen. 
In diesem Abschnitt werden die Grundlagen des Hinzufügens und Verwaltens von Schriften erläutert. Weitere 
Informationen zur Verwendung von Suitcase Fusion finden Sie unter „Hilfe“ > „Suitcase Fusion Hilfe“ (Help > 
Suitcase Fusion Help).

Hinzufügen Ihrer Schriften
Schriften zu Suitcase Fusion hinzufügen:

1. Wählen Sie “Datei” > Füge Schrift zur Bibliothek dazu“ (File > Add Fonts to Library)
2. Suchen Sie Ihren Ordner Optionale Schriften auf Ihrem Desktop und klicken Sie auf „Hinzufügen“

Suitcase Fusion erstellt ein Set namens „Optionale Schriften“ (Optional Fonts) und fügt die Schriften dem 
Set hinzu. Sie können die Ordner auch in „Optionale Schriften“ (Optional Fonts) in die Schrift-Bibliothek 
(Font Library) in der Seitenleiste des Suitcase Fusion-Hauptfensters ziehen. Suitcase Fusion erstellt für 
jeden Ordner ein Set und fügt die Schriften zu den Sets hinzu.

Hinzufügen von Schriftarten zu temporären Schriften
Bei einigen Projekten möchten Sie möglicherweise keine Schriften dauerhaft zu Ihrer „Schrift-Bibliothek“ 
(Font Library) hinzufügen. Sie können sie in den Ordner „Temporäre Schriften“ (Temporary Fonts) in der 
Seitenleiste von Suitcase Fusion ziehen oder auf das Suitcase Fusion-Symbol im Dock ziehen. Schriften in 
„Temporäre Schriften“ (Temporary Fonts) werden aus Suitcase Fusion entfernt, wenn Sie sich von Windows 
abmelden oder Ihren PC neu starten.

Hinweis: Schriften, die vorübergehend hinzugefügt werden, werden nicht in den Depotbereich kopiert, sondern 
an Ort und Stelle hinzugefügt. Wenn Sie einen Ordner mit Schriften verschieben, nachdem Sie ihn zu „Temporäre 
Schriften“ (Temporary Fonts) hinzugefügt haben, kann Suitcase Fusion ihn nicht verwenden.

Sets erstellen und löschen
Sobald Ihre Schriften hinzugefügt wurden, können Sie die erstellten Sets löschen, wenn Sie anders organisieren 
möchten. Wählen Sie ein Set aus und wählen Sie „Bearbeiten“ > „Set löschen“ (Edit > Delete Set...), um ein Set 
zu entfernen.

Um ein neues Set zu erstellen, wählen Sie „Datei“ > „Neues Set“ (File > New Set) und geben Sie Ihrem Set einen 
Namen. Um Schriften zu einem Set hinzuzufügen, wählen Sie die Schrift aus der Schriftbibliothek aus und 
ziehen sie auf den Set-Namen.

Verwalten doppelter Schriften
Wenn Sie im Laufe der Zeit Schriften zu Suitcase Fusion hinzugefügt haben, werden Sie eventuell feststellen, 
dass Sie Duplikate einiger Ihrer Schriften haben. Suitcase Fusion erlaubt es Ihnen nicht, die gleiche Schrift mehr 
als einmal dem Schriftdepot hinzuzufügen; aber es werden Schriften mit dem gleichen PostScript-Namen, aber 
unterschiedlichen Versionsnummern oder Schriftformaten hinzugefügt.

Meistens ist es das, was Sie wollen – wenn Sie mit älteren Dokumenten oder Projekten arbeiten, die von anderen 
Personen erstellt wurden, möchten Sie die gleichen Schriften verwenden, mit denen die Dokumente erstellt 
wurden. Ist dies nicht der Fall, möchten Sie möglicherweise ältere Kopien entfernen, um sicherzustellen, dass 
Sie die neueste Version Ihrer Schriften verwenden.

1. Öffnen Sie Suitcase Fusion
2. Klicken Sie im Bereich „Smart Searches“ in der Seitenleiste auf Duplicate Fonts

Auf dem Display werden Schriften angezeigt, die den gleichen PostScript-Namen haben. Wenn die Schriften 
nach Familien gruppiert sind, können Sie die Anzeige jeder Schrift individuell gestalten, indem Sie das 
Kontrollkästchen „Ansicht“ > „Schriften nach Familien gruppieren“ (View > Group Fonts by Family) deaktivieren.

Sie können Schriften auswählen und „Bearbeiten“ > „Löschen“ (Edit > Delete) wählen (oder die Taste „Entfernen“ 
drücken), um sie aus Ihrer Schriftbibliothek zu entfernen. WICHTIG: Dadurch werden sie aus dem Schriftdepot 
gelöscht, also stellen Sie bitte vorher sicher, dass Sie Sicherungskopien haben!
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Erstellen Sie einen Plan für die Zukunft
Sie haben Ihre Schriftenordner des Betriebssystems bereinigt, schlechte Schriften entfernt und sie 
zu Suitcase Fusion oder einem anderen Font-Manager hinzugefügt. Jetzt ist es Zeit, einen Plan für 
die Zukunft auszuarbeiten.

Organisieren Ihrer Schriften mit FontDoctor
Sie können Ihre Schriften in den von Ihnen erstellten Ordnern Optional Fonts aufbewahren. Vielleicht 
möchten Sie in Schriftenfamilien organisieren, um das Auffinden einzelner Schriften zu erleichtern. 
FontDoctor kann einen Ordner mit Schriften in einer neuen Ordnerstruktur organisieren:

1. Öffnen Sie FontDoctor
2. Klicken Sie unter „Scannen & Organisieren“ (Scan & Organize) auf Show Options
3. Wählen Sie den Ordner aus, den Sie organisieren möchten
4. Wählen Sie den Ordner aus, in den Sie die organisierten Schriften einfügen möchten
5. Wählen Sie, wie Sie Ihre Schriften sortieren und gruppieren möchten, und klicken Sie dann 

auf Start Scan

FontDoctor scannt Ihre Schriften und sortiert sie in Ordnergruppen. Sie können denselben Zielordner 
mehrmals verwenden, um alle Ihre Schriften in einer Sammlung zusammenzufassen.

Sichern Ihrer Schriften
Die einfachste Möglichkeit zum Schutz Ihrer Schriften besteht darin, sie zusammen mit ihren 
restlichen Dateien zu sichern. Wenn Sie bereits Backup-Software von Drittanbietern verwenden, 
sind Sie bestens gerüstet! Stellen Sie sicher, dass sich Ihre Schriften in einem Ordner befinden, der 
gesichert wird. Sie können sie in ein .zip-Archiv komprimieren, indem Sie mit der rechten Maustaste 
auf das Ordnersymbol klicken und dann „Senden an“ > „Komprimierter (gezippter) Ordner“ wählen 
(Send to > Compressed (zipped) folder).

Sie können auch ein Backup Ihres Suitcase Fusion Schriftendepots erstellen. Wählen Sie „Datei“ > 
„Schriftdepot-Archiv“ > „Archivieren…“ (File > Font Vault Archive > Archive)..) und wählen Sie einen 
Speicherort für die Backup-Datei aus. Suitcase Fusion erstellt eine Datei mit einer Erweiterung 
von .winbackup und sichert Ihr gesamtes Schriftendepot: Schriften, Sets und benutzerdefinierte 
Metadaten. Stellen Sie anschließend sicher, dass Sie die Sicherungsdatei an einem sicheren Ort 
aufbewahren.

Suitcase Fusion verfügt auch über TypeSync, eine Synchronisierungsfunktion, die Ihr Schriftendepot 
in die Cloud kopiert. Wenn Sie sich bei einer neuen Kopie von Suitcase Fusion anmelden, werden 
Ihre Schriften und -sets automatisch zu Ihrem Schriftendepot hinzugefügt. Weitere Informationen zu 
TypeSync erhalten Sie, indem Sie Hilfe> Suitcase Fusion-Hilfe wählen (Help > Suitcase Fusion Help).

Wenn Sie einen anderen Font-Manager verwenden, lesen Sie in der entsprechenden Dokumentation 
nach, ob es Funktionen für ein Backup Ihrer Schriftsammlung gibt.

Neue Schriftarten erhalten und mit ihnen arbeiten
Machen wir uns nichts vor: Es gibt nicht genug Schriften. Sie werden irgendwann mehr Schriften 
erhalten, also sollten Sie wissen, was Sie mit ihnen machen werden.

Sie können Schriften über den Windows Store in Windows 10 erwerben. Schriften, die über den 
Microsoft Store gekauft wurden, werden nicht in C:\Windows\Fonts\ gespeichert, und nicht alle 

Windows-Anwendungen können sie sehen.
Weitere Informationen finden Sie unter New ‘Pro’ fonts in Windows 10.
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Neue Schriften kaufen
Wenn Sie neue Schriften kaufen, sollten Sie ein paar Dinge beachten:

• Kaufen Sie Ihre Schriften von bekannten, zuverlässigen Schriftherstellern oder Websites
• Vergewissern Sie sich, dass die von Ihnen gekauften Schriften die benötigten Stile, Sprachen 

und Symbole enthalten
• Versuchen Sie, Schriften im OpenType-Format oder TrueType abzurufen, sofern keine 

OpenType-Schriften angeboten werden
• Vermeiden Sie Sammlungen von Tausenden von Schriften zu einem niedrigen Preis: Die 

meisten Schriften werden „lustige“ Displayschriften sein, die Sie selten verwenden werden 
und die wahrscheinlich von geringer typografischer Qualität sind.

Herunterladen kostenloser Schriften
Seien Sie vorsichtig beim Herunterladen von Schriften von „Free Font“-Websites. Es gibt bekannte 
Schriftenanbieter, die kostenlose Schriften anbieten, wie Apple, Adobe, Microsoft und Monotype. 
Wenn Sie kostenlose Schriften verwenden möchten, laden Sie von Websites herunter, denen Sie 
vertrauen können.

Viele „Free Font“-Websites bieten nur Schriften geringer Qualität an. Manchmal sind die von solchen 
Seiten angebotenen Schriften Nachbildungen beliebter Schriften, die nicht die gesamte Bandbreite an 
Glyphen und Funktionen der professionell gestalteten Schriften aufweisen. Möglicherweise bieten sie 
auch Raubkopien von kommerziellen Schriften an - im Zweifelsfall sollten Sie diese nicht verwenden!

Umgang mit Schriften, die mit Anwendungen installiert wurden
Einige Anwendungen enthalten hochwertige Schriften, die Sie verwenden können. Die Software 
kann eventuell ihre Schriften in Ihren Systemschriftordnern oder an anderen Orten installieren, an 
denen Ihr Font-Manager sie nicht verwalten kann. Wenn Sie der Meinung sind, dass Ihre Anwendung 
neue Schriften installiert hat, Sie diese aber nicht finden können, lesen Sie die Dokumentation der 
Anwendung oder die Website des Entwicklers, um Unterstützung zu erhalten.

Erstellen Sie einen Ordner, der nach der Anwendung benannt wird (z. B. Finale Fonts) auf dem 
Desktop. Nachdem Sie Ihre Anwendung installiert haben, überprüfen Sie Ihren Systemschriftenordner 
anhand der Liste der Systemschriften für Ihre Windows-Version. Sie können alle neu hinzugefügten 
Schriften in den Anwendungsordner verschieben, den Sie auf dem Desktop erstellt haben. Von dort 
können Sie einem Font-Manager hinzufügen.

Arbeiten mit Ihren neuen Schriften
Wenn Sie Ihre Schriften von einem vertrauenswürdigen Anbieter beziehen, werden diese 
wahrscheinlich keine Probleme haben. Sie können FontDoctor weiterhin verwenden, um sie nach 
Problemen zu durchsuchen und sie Ihrer organisierten Sammlung von Ordnern hinzuzufügen.

Wenn Sie die Schriften zu Ihrem Font-Manager hinzufügen, möchten Sie diese vielleicht als Set 
hinzufügen, damit Sie später identifizieren können. Wenn Ihr Font-Manager es Ihnen ermöglicht, 
Notizen oder Tags zu einer Schrift hinzuzufügen, möchten Sie möglicherweise Bestellinformationen, 
Schriftanbieter und Kundeninformationen hinzufügen.

Was jetzt?
Das war's! Wenn Sie so weit gekommen sind, dann sollten Sie einen sauberen Schriftenordner des 
Betriebssystems haben, Ihre Schriften zu Ihrem Fontmanager hinzugefügt und nach Ihren Wünschen 
organisiert haben, Sicherungskopien Ihrer Schriften für den Fall, dass etwas schief geht angelegt, und 
einen Plan haben für das, was mit Ihren neuen Schriften geschehen soll. Gehen Sie jetzt raus und 
seien Sie kreativ!
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 Anhang A: Arbeiten mit Windows 
Wiederherstellungspunkten
Erstellen eines Wiederherstellungspunkts in Windows
Windows 7:

1. Klicken Sie auf die Schaltfläche „Start“ (Start button) und anschließend auf „Systemsteuerung“ 
(Control Panel)

2. Klicken Sie in der „Systemsteuerung“ (Control Panel) auf System
3. Klicken Sie im linken Fensterbereich auf Systemschutz; wenn Sie zur Eingabe eines Passworts 

aufgefordert werden, geben Sie Ihr Administratorpasswort ein.

Windows 10:

1. Öffnen Sie das Startmenü und wählen Sie „Windows System“ > „Systemsteuerung“ 
(Windows System > Control Panel)

2. Klicken Sie in der „Systemsteuerung“ (Control Panel) auf „System“
3. Klicken Sie im linken Fensterbereich auf Systemschutz (System protection); wenn Sie zur Eingabe 

eines Passworts aufgefordert werden, geben Sie Ihr Administratorpasswort ein.

Gehen Sie im Fenster Systemeigenschaften zu den Schutzeinstellungen, wählen Sie „Lokale 
Festplatte (C:)(System)“ und klicken Sie auf Konfigurieren (Configure)… Klicken Sie auf Wiederherstellen 
von Systemeinstellungen und früheren Versionen von Dateien (Restore system settings and previous versions of 
files), dann klicken Sie auf OK, um das Fenster zu schließen. 

Um einen Wiederherstellungspunkt zu erstellen, klicken Sie auf Erstellen (Create)… und geben Sie 
eine Beschreibung für den Wiederherstellungspunkt ein (z.B. „Vor dem Entfernen von Schriften von 
Drittanbietern“), dann klicken Sie auf Erstellen (Create).

Zurücksetzen des Systems von einem Wiederherstellungspunkt aus
Wenn Sie einen Wiederherstellungspunkt erstellt haben, bevor Sie Schriften aus Ihrem 
Systemschriftenordner verschoben haben, können Sie Windows im Problemfall wieder auf den 
Wiederherstellungspunkt zurücksetzen.

Windows 7: Klicken Sie auf die Schaltfläche „Start“ (Start Button) und wählen Sie „Alle 
Programme“ > „Zubehör“ > „Systemprogramme“ > „Systemwiederherstellung“ (All Programs > 
Accessories > System Tools > System Restore).

Windows 10: Öffnen Sie das Startmenü (Start Menu) und wählen Sie „Windows System“ > 
„Systemsteuerung“ (Windows System > Control Panel). Klicken Sie in der „Systemsteuerung“ 
(Control Panel) auf „Wiederherstellung“ (Recovery), dann auf Öffnen der Systemwiederherstellung 
(System Restore).

Klicken Sie im Assistenten für die Systemwiederherstellung (System Restore) auf Weiter (Next), 
um die Liste der Wiederherstellungspunkte anzuzeigen. Wenn Ihr Wiederherstellungspunkt in 
Windows 7 nicht sichtbar ist, aktivieren Sie das Kontrollkästchen Weitere Wiederherstellungspunkte 
anzeigen (Show more restore points). Wählen Sie den gewünschten Wiederherstellungspunkt in der 
Liste aus und klicken Sie auf Weiter (Next). Stellen Sie sicher, dass der von Ihnen ausgewählte 
Wiederherstellungspunkt der richtige ist, und klicken Sie dann auf „Fertigstellen“ (Finish).

Windows warnt Sie, dass die Rücksetzung auf den Wiederherstellungspunkt nicht rückgängig 
gemacht werden kann; klicken Sie auf „Ja“ (Yes). Wenn Windows mit der Rücksetzung auf den 
Wiederherstellungspunkt fertig ist, wird Ihr PC neu gestartet.
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